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Design Analysis Using Tcl Commands 
Demo Script 

Introduction 

In this demonstration, you will perform design analysis by finding objects, object properties, and 
object connectivity by using Tcl commands. 

Preparation: 

• Necessary project files are located in the following directory: 
$TRAINING_PATH/Tcl_Dsgn_Analysis/demo/KCU105/verilog 

• Required hardware: None 
 

Finding Objects 
 

Action with Description Point of Emphasis and Key Takeaway 

• Launch the Vivado™ Design Suite. 

• Unzip the project using the Tcl Console: 

exec unzip 

$::env(TRAINING_PATH)/Tcl_Dsgn_

Analysis/demo/KCU105/verilog.zi

p -d 

$::env(TRAINING_PATH)/Tcl_Dsgn_

Analysis/demo/KCU105/verilog 

• Open the wave_gen.xpr project from the 
following directory: 
$TRAINING_PATH/Tcl_Dsgn_Analysi

s/demo/KCU105/verilog 

• You can easily open an existing Vivado IDE 
project via the Getting Started page. 

• Open the implemented design. • You can open the implemented design by using: 

• The Flow Navigator 

• The Tcl Console 

• The horizontal toolbar 

• The implemented design shows how the logic 
will be placed on resources. It allows you to 
generate various clock and timing report. 

• Is the hierarchy maintained in the implemented netlist? 

• Yes, hierarchy is maintained. You can view the netlist hierarchy in the Netlist window 
(Window > Netlist). You can also review the hierarchy settings for the project in the 
synthesis settings. 
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Action with Description Point of Emphasis and Key Takeaway 

• Enter get_cells in the Tcl Console to 

get all the cells in the design within the 
current level of the hierarchy. 

• The Tcl interface provides commands for getting 
objects. Some of them include: 

• get_cells, get_nets, get_ports, 
get_pins 

• With no options, these commands return a list of 
all objects at the current level of hierarchy. 

• The current level of hierarchy is the top level 
of the design unless changed by the user. 

• Note: As you enter get_ in the Tcl Console, the 

Vivado Design Suite lists all the commands 
supported by it. 

• What is the output of the get_cells command? Is this expected? How many cells are 

returned by the get_cells command? 

• The get_cells command returns the list of cells at the current level of hierarchy (in this 

case top_level). This list does not include any cells from the hierarchical cells (sub-blocks) 
under the top level.  

• Enter the llength [get_cells] command to determine the number of cells returned by 

the get_cells command. 

• Enter get_cells –hierarchical in 

the Tcl Console. 

• This command lists all the cells in the design. 

• The –hierarchical option can be used with 

cells, pins, or nets. 

• Enter get_cells uart_rx in the Tcl 

Console. 

• If no object of that name given in the command 
exists, the command will return a null list with a 
warning message. 

• The uart_rx cell is taken as an example here. 
You can use any other cell. 

• Enter get_cells uart_rx_i0 in the 

Tcl Console. 

• This returns the cell uart_rx_i0 from the current 
level of the hierarchy. 

• Enter get_cells OBUF_dac_c*_n in 

the Tcl Console to use a wildcard to 
match characters. 

• Enter get_cells OBUF_dac_c?_n. 

• The names given in the command can have 
wildcards. 

• How did the wildcards * and ? match the characters differently in each case? 

• The wildcard * matches any number of characters, so the command with * returns two cells 
OBUF_dac_clr_n and OBUF_dac_cs_n. 

• The wildcard ? matches a single character, so the command using ? returns 
OBUF_dac_cs_n. 
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Action with Description Point of Emphasis and Key Takeaway 

• Enter get_cells -regexp 

{[Rr]st.*} in the Tcl console. 

• Using the -regexp option specifies that the 

search patterns are written as regular 
expressions.  

• You can add ".*" to the beginning or end of a 
search string to match any number of 
characters. 

• This command searches for strings starting with 
Rst or rst and has any number of characters 
after that. 

• Enter get_cells -hierarchical 

uart_baud_gen_* in the Tcl Console. 

• By default, the get_* commands only search 

for objects starting at the current level of 
hierarchy. 

• The option –hierarchical will search at all 

levels of the hierarchy. 

• Enter get_pins 

samp_gen_i0/rst_clk_tx in the Tcl 

Console. 

• Pin names are based on the instance they 
belong to. 

• When searching for pins, you must use the 
hierarchy separator to separate the instance 
name and the pin name patterns. 

• The command returns the clk_tx pin of the 
samp_gen_i0 instance. 

• Enter get_pins -hierarchical */C 

in the Tcl Console. 

• This command returns the C pins of any cell in 
the design as the wild card * is used to match 
pin names. 

• Note that the pin names look hierarchical, but 
they are not. 

• For example, pin C of the instance. 
signal_meta_reg is named as 
signal_meta_reg/C. 

• This does not mean that the C pin is inside 
the hierarchy of the instance 
signal_meta_reg. 

• The final / in a pin name is not a hierarchy 
separator, it is part of the pin name. 
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Action with Description Point of Emphasis and Key Takeaway 

• Enter get_nets txd_tx in the Tcl 

Console. 

• Enter show_schematic [get_nets 

txd_tx] in the Tcl Console. 

• Enter select_objects [get_nets 

txd_tx] in the Tcl Console. 

• The txd_tx net is used as an example here, you 
can choose any other net as well. 

• The get_nets txd_tx command returns the 

net txd_tx, if present in the current level of 
hierarchy. 

• The show_schematic command creates a 

Schematic view containing the specified design 
objects. 

• The select_object command highlights the 

selected object in the GUI (including in the 
Schematic view). 

 

• Enter get_nets txd_tx -segments to 

return all the segments of the net 
rx_data[0]. 

• Enter show_schematic [get_nets 

txd_tx -segments] in the Tcl Console. 

• Enter select_objects [get_nets 

txd_tx -segments] in the Tcl Console. 

  

• A single logical net can have multiple segments. 

• Within each hierarchical object, the net can 
have a different segment. 

• Each segment is a different net object. 

• The get_nets command with –segments 

option can be used to find the segments of a 
net. 

• One of the segments will be considered the 
parent segment. All the other segments will 
have the PARENT property set to refer to this 
segment. Accessing the properties will be 
covered in the next part of the demo. 
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Action with Description Point of Emphasis and Key Takeaway 
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Object Properties 
 

Action with Description Point of Emphasis and Key Takeaway 

• Select any cell from the netlist (clk_gen_i0, 
for example). 

• View the class type and other properties 
from the Cell Properties window. 

 

• Object properties can be seen by selecting 
an object. 

• The selection can be done in a 
schematic or any object list. 

• Only the most common properties and 
properties that are at their non-default 
value are shown in the Cell Properties 
window. Additional defined properties can 
be added to the view by right-clicking in the 
window and selecting Add Properties or 
by clicking the  sign. A popup window 
will show all possible properties that can be 
added to the view. 

• Enter report_property [get_cells 

clk_gen_i0] in the Tcl Console. 

• Enter report_property -all 

[get_cells clk_gen_i0] in the Tcl 

Console. 

• The report_property command returns 

the property name, property type, and 
property value for all of the properties on a 
specified object or class of objects. 

• You can specify objects for 
report_property by using the get_* 

series of commands to get a specific 
object. 

• The -all option returns all of the 

properties for an object even if the property 
value is not currently defined. 
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Action with Description Point of Emphasis and Key Takeaway 

• Enter list_property –class net in the 

Tcl Console to list all the properties of net. 

• This command will list any property that 
can be had by any object of class-type net. 

• All objects of a given class have the same 
set of properties. 

• You can use report_property instead 

of list_property to get the description 

and type of the property. 

• Enter the following commands in the Tcl 
Console and observe the output: 

• get_property bus_width 

[get_nets rx_data[0]] 

▪ This command returns the value of 
the property bus_width of the object 
net rx_data[0]. 

• get_property slew [get_nets 

rx_data[0]] 

▪ This command returns nothing. 
Why? 

• All property values can be obtained via the 
get_property Tcl command. 

• get_property gets the current value of 

the named property from the specified 
object or objects. 

• If the property is not currently assigned to 
the object, or is assigned without a value, 
then the get_property command returns 

nothing, or the null string. 



Design Analysis Using Tcl Commands Demo Script Demonstration Workbook 

 

8 www.amd.com 

 © Copyright 2025 Advanced Micro Devices, Inc. 
 

Action with Description Point of Emphasis and Key Takeaway 

• Enter the following command in the Tcl 
Console: 

• set_property MARK_DEBUG 1 

[get_nets {rx_data[0]}] 

▪ This command sets the property 
mark_debug of the net rx_data[0]. 

• How can you verify whether the property is 
set or not? 

• Use the get_property command: 
 
get_property MARK_DEBUG 

[get_nets {rx_data[0]}] 

 

• Properties that are not read only can be set 
via the set_property Tcl command. 

• The set_property command sets the 

property on object. 

• Properties can also be modified directly in 
the Attributes pane of the Instance 
Properties window in the GUI by 
right-clicking the particular net and 
selecting Net Properties. 

 

• Note that the property you set through the 
Tcl command is reflected in the GUI. This 
shows the interoperability between the Tcl 
interface and the GUI. 
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Action with Description Point of Emphasis and Key Takeaway 

• Select any primitive cell 
(uart_rx_i0/meta_harden_rxd_i0/Leaf 
Cells/signal_dst_reg, for example) from the 
Netlist window and view the properties 
from the Cell Properties window. 

 

• All objects have a CLASS property, which 
determines which type of object it is. 

• NAME is the full hierarchical name of the 
object. 

• IS_PRIMITIVE indicates that it is a 
primitive cell (as opposed to a hierarchical 
cell). 

• IS_SEQUENTIAL indicates that it is a 
clocked element. 

• REF_NAME is the name of the library cell, 
module, or entity of which this object is an 
instance. 

• The library cell attributes (i.e., MMCM, 
Block RAM, …) are all properties. 

• Similarly, you can select any hierarchical 
cell. 

• A hierarchical cell is a module or block that 
contains one or more additional levels of 
logic and eventually concludes at primitive 
cells. 

•  Enter report_property [get_ports 

led_pins[0]] in the Tcl Console. 

Note: You can open the elaborated design and 
select the port from the schematic and view the 
properties from the Property window 

• DIRECTION is the direction of the port. 

• I/O attributes are all properties of the port: 

• IOSTANDARD, SLEW, DRIVE, 
PULLUP, PULLDOWN, KEEPER 

• PACKAGE_PIN is the FPGA pin used for 
the port. 
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Action with Description Point of Emphasis and Key Takeaway 

• Select any pin from the schematic and view 
its properties or use the 
report_property and get_pins 

commands to view the properties of the 
pin. 

• report_property [get_pins 

rst_gen_i0/rst_clk_rx] 

• This command returns the properties of 
the pin rst_gen_i0/rst_clk_rx. 

• DIRECTION indicates if this pin is an IN, 
OUT, or INOUT. 

• IS_LEAF indicates if this is the pin of a leaf 
cell or a pin of a hierarchical cell. 

• IS_CLOCK indicates if this is a clock pin to 
a clocked object. 

• IS_RESET, IS_PRESET indicate if this pin 
is a reset or preset pin of a clocked object. 

• IS_ENABLE indicates if this pin is a clock 
enable pin of a clocked object. 

• Enter create_property –type bool 

MY_PROPERTY cell in the Tcl Console. 

• Creates the property MY_PROPERTY 
for all objects of the class cell, which 
can accept a Boolean value. 

• New properties can be added to a class of 
objects with the create_property Tcl 

command. 

• create_property –type <type> 

<name> <class> 

• <type> can be string, int, long, 

double, or bool. 

• <class> can be cell, pin, net, or 

port. 

• <name> is the name of the new 

property to be created. 

• Once added to a class, the new property 
can be used in the same way as other 
properties. 

• Enter filter [get_ports] 

{DIRECTION == IN} in the Tcl Console. 

• Properties can be used to filter lists of 
objects with the filter Tcl command. 

• filter <objects> 

<filter_expression> 

• <objects> is a list of objects to filter. 

• <filter_expression> is the filter 

expression to use. 

• Returns the list of objects from the 
<objects> list that match the 

<filter_expression>. 
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Action with Description Point of Emphasis and Key Takeaway 

• Enter get_cells -hierarchical 
-filter { PRIMITIVE_TYPE =~ 

*MMCME3_ADV* } in the Tcl Console. 

• This command returns cells with the 
primitive_type property matching 
*MMCME3_ADV*. 

• You can also filter a list of objects based on 
the property with the –filter option of 

the get_* command. 

• get_cells –filter 

<filter_expression>  

• All options of the get_cells 

command can be used (-hierarchy, 

...) 

• Filter expressions are strings. They are 
usually enclosed in {}, but "" can be used 

as well. 

• Select Edit > Find. 

• Select the cells in the Find section. 

• Select PRIMITIVE_TYPE is 
CLOCK.PLL.MMCME3_ADV in the 
Properties section. 

• Click OK to find the objects matching the 
search pattern. 

• You can use the Edit > Find command or 
the <Ctrl + F> keyboard shortcut to search 
for design objects. 

• The command bar in the Find window 
shows the Tcl command that is run to 
populate the Find Results window. 
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Object Connectivity 
 

Action with Description Point of Emphasis and Key Takeaway 

• Select wave_gen > Nets > clk_pin_p from 
the Netlist window. 

• Press <F4> to show the schematic of the 
clk_pin_p net. 

• Note the pins and cells connected to the 
net. 

• How can you get pins connected to a 
particular net? 

• Enter get_pins –of_objects 

[get_nets clk_pin_p] in the Tcl 

Console. 

• This command returns the pins 
connected to the net clk_pin_p. Note 
that this net is connected to a port at 
one end and a pin at another end. 
Hence it results in only one pin name; 
i.e., clk_gen_i0/clk_pin_p.  

• Objects within the database are related to 
each other to form the connectivity of the 
netlist. 

• This connectivity can be accessed by using 
the Tcl get_* commands. 

• The -of_objects option returns the list 

of objects connected to the specified 
object. The -of option is the same as 

-of_objects. 

• This enables you to find objects based on 
netlist connectivity. 
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Action with Description Point of Emphasis and Key Takeaway 

• Enter get_pins –of_objects 

[get_nets clk_pin_p] –leaf in the 

Tcl Console. 

• How was the output different from the 
previous command? 

• When finding the pins connected to a net 
that crosses a hierarchical boundary, you 
can find either the pins of the hierarchical 
objects or the pins of the primitive objects. 
This is controlled by the use of the –leaf 

option. 

• Without –leaf, the hierarchical objects 

pins will be returned. 

• With –leaf, the pins of the primitive 

objects will be returned, regardless of 
where they are in the hierarchy.   

 

• You can expand the cells from the 
schematic of clk_pin_p to understand the 
output. 

• Select wave_gen > Nets > char_fifo_din 
from the Netlist window and press <F4> to 
view the schematic. 

• What would be the Tcl command to get cell 
resp_gen_i0 from the cell char_fifo_i0 
based on object connectivity? 
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Action with Description Point of Emphasis and Key Takeaway 

 

• Multiple get_* commands can be nested 

with the –of_objects option to perform 

arbitrarily complex searches through the 
design database. 

• Apart from resp_gen_i0, what else did the 
command return? And why? 

• The get_nets in the command would 

return more than one object, and hence 
the resulting list of objects would 
include far more than just resp_gen_i0. 

• Select wave_gen > lb_ctl_i0 > leaf_cells 
> txd_o_reg from the Netlist window and 
view the schematic. 

• Using the schematic, what are the fan_in 
objects of pin D of the txd_o_reg cell? 

• Double-click the cell pin D to trace the 
source. 

• Double-click the three inputs of the 
LUT3. 
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Action with Description Point of Emphasis and Key Takeaway 

• Enter all_fanin [get_pins 

lb_ctl_i0/txd_o_reg/D] in the Tcl 

Console. 

• If you want to visualize the output of the 
above command on multiple lines, you can 
use the built-in command join to insert a 
"newline" character in between each 
element of the list returned by the 
command 

• join [all_fanin [get_pins 

lb_ctl_i0/txd_o_reg/D]] \n 

• The all_fanin command returns a list of 

pins that can combinatorially reach the 
specified pin, port, or net. 

• Use the select_objects command to select 
the output of the above command in the 
GUI: 

• select_objects [all_fanin 

[get_pins 

lb_ctl_i0/txd_o_reg/D]] 

• Did the command select all the pins you 
see in the schematic? 

• You can observe that the 
uart_tx_i0/uart_tx_ctl_i0/txd_tx_reg/Q 
pin is not highlighted as this pin is not in 
the same level of hierarchy as 
lb_ctl_i0/txd_o_reg/D. 

• Enter select_objects [all_fanin 
[get_pins lb_ctl_i0/txd_o_reg/D] 

-flat -startpoints_only] in the Tcl 

Console. 

• When the -startpoints_only option is 

used, none of the intermediate points in the 
fan-in network are returned. This option 
can be used to identify the primary driver(s) 
of the sinks. 

• Similarly, the -only cells option returns 

only the cell objects that are in the fan-in 
path of the specified sinks. This does not 
return pins or ports. 

• Enter all_fanout [get_pins 

lb_ctl_i0/txd_o] in the Tcl console. 

• The all_fanout command returns a list 

of all objects that can be combinatorially 
reached from a specified pin, port, or net. 

• Has similar options as all_fanin. 

• Use –endpoints_only to restrict it to 

sequential cells. 

• Use different options as in all_fanin and 

observe the results. 

• Close the implemented design and exit the 
Vivado Design Suite. 
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Summary 

This demonstration illustrated how to find objects, and how to observe objects properties and 
object connectivity by using Tcl commands. 

References: 

• Supporting materials 

• Vivado Design Suite Properties Reference Guide (UG912) 

• Vivado Design Suite User Guide: Using Tcl Scripting (UG894) 

• Vivado Design Suite Tcl Command Reference Guide (UG835) 

 


